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Tutorials of GPS Survey
@ Contents

- Orbits (precise or broadcast)

- Data rate and observation span

- Elevation angle

- Points to be observed on your lab.

- Processing software and methodology
- Processing GPS data

- Appendix: WGS84 System, GPS Height
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Tutorials of GPS Survey
€ Recording GPS observation

* GPS measures ranges.

« If a reference station is on a
known location then the range
can be calculated.

* The difference between the
measured and calculated
ranges is measurement error.

* The error measured at a
reference station is similar to
the error measured by nearby
receivers (- differential
approach)
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Tutorials of GPS Survey
€ GPS Orbits

1. Broadcast orbit from GPS satellites (Real-Time Processing)

2. IGS Products (In Near Real-Time Processing)

The IGS (international GNSS service) collects, archives, and distributes GPS
and GLONASS observation data sets of sufficient accuracy to meet the
objectives of a wide range of scientific and engineering applications and
studies. These data sets are analyzed and combined to form the IGS
products.

IGS products support scientific activities such as improving and extending
the International Terrestrial Reference Frame (ITRF) maintained by the
International Earth Rotation and Reference Systems Service (IERS),
monitoring deformations of the solid Earth and variations in the liquid
Earth (sea level, ice sheets, etc.) and in Earth rotation, determining orbits
of scientific satellites, and monitoring the troposphere and ionosphere.

( ) IGS: SOPAC, CDDIS, IGN, KASI - US,
France, and Korea
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Tutorials of GPS Survey

& GPS Orbits (in 2009)

1GS Product Table |[GPS Broadcast values included for comparison)

Accuracy  Latency  Updates

ollite Ephemerides/
& Station Clocks

four times

four times
daily

orbits

Sat & Sm
clocks

ocbits
. Sat & Sm. REE
clocks

Sample Iaterval

daily

5 min

Archive locations

CDDIS(US-MD)
SOPAC(US-CA)
IGN(FR)

CDDIS(US-MD)
1GS CB(US-CA)
SOPAC(US-CA)
IGN(FR)
KASI (KOREA)
CDDIS(US-MD)
105 CB(US-CA)
SOPAC(US-CA)
IGN(FR)
KASI (KOREA)

CDDIS(US-MD)
1GS CB(US-CA)
SOPAC(US-CA)
IGN(FR)
KAS] (KOREA)
CDDIS(US-MD)
1GS CB(US-CA)
SOPAC{US-CA)
LGNFR) (accessed on
KASI(KOREA) 21 March 2009)

Note: These values are differences from SLR measurements. Also, even if there is
an errors, it can be minimized by differential techniques on GPS processing.
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Tutorials of GPS Survey

® GPS Orbits (in 2010, 2011

Accuracy  Latency Updates Sample Interval

=il tme dadv
rcalbme U"'S_f.',_.l" at 15 min
Ulra-Rapid 03,09, 15,21 :
(bserved ) | s ook =8 o uTe e
cabits 15 min
Rapid 1T-41 | 1 U ey
Sat & 5m  ~TSpsRMS  hours T 5 i
chocks ~25 ps SDev
orbits 15 min
Finad Lot every Thursday
Sat &St (~TSpsRMS  days - & Sat: 30s
clocks | ~20 ps SDev S § min

1GS Product Table [GPS Broadcast values included for comparison] - updated for 2009!

)

Archive locations

CDDIS{US-MD)
SOPAC(US-CA)
1GN(FR)

)
SOPAC(US-CA)
IGN(FR)
KASI (KOREA)

CDDIS(US-MD)
IGS CBIUS-CA)
SOPAC(US-CA)
IGN(FR)
KASI (KOREA)

CDDIS(US-MD)
1G CA)
SOPAC(US-CA)
IGN(FR)
KASI (KOREA)

CDDIS(US-MD)
1GS CB(US-CA)
SOPAC(US-CA)
IGN(FR)
KASI (KOREA)

Note: Compared these
with last year,

1) All orbits are
dramatically improved.

2) Clock errors are also
improved.

3) The improvements
are very beneficial in
“precise point
positioning”.

4) In your field survey
designed, the broadcast,
ultra-rapid or rapid
orbit is fine.

(accessed on
22 March 2010 & 22 March 2011)
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| Tutorlals of GPS Survey
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Tutorials of GPS Survey

@ Data Rates and Minimum Obs. Time

- More data means more redundancy - at least 5 seconds
data rate would be recommended. Normal value for the data
rate is 30 seconds because of the storage issues, and it
depends on the observation time.

- Minimum observation time? at least 30min, 45min

-- Hint: In principle, the position can be determined with one
epoch in terms of “least square adjustment”’. We are dealing
with carrier phases (+code). There is unknown value on the
equation, called integer ambiguity, which may need to be
determined during the process.

- Masking angle? 5 deg. (not suggested over 10 deg.)
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Tutorials of GPS Survey
@ GPS Processing Software:

[Geodetic Software - post mission, examples]

: Bernese GPS Software (from AIUB - Astronomical Institute of
University of Bern, Bern, Switzerland, Available for our GGE
department, academic & commercial)

: GIPSY-OASIS II (from NASA JPL, free)
: GAMIT (from MIT), DIPOP (from UNB, free)

[Commercial Software- post mission mostly, examples]

: TGO™ (Trimble Geomatics Office)

: TTC™ (Trimble Total Control), Topcon Tools, Leica Geosystem’s Ski Pro
: GrafNav™ (from NovAtel Inc., Calgary)

: MultiRef™, FlyKin™ (from Geomatics Eng. at U of Calgary)

: UNB-RTK (from GGE), Precise Point Positioning (free software, NRCan
(Canada), Auto-GIPSY (NASA, ~free), UNB-GAPS (UNB, free)) etc.
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Tutorials of GPS Survey
€ GPS Processing Methodology

[Measurements from a GPS Rx, Trimble, Leica, or TOPCon receiver]

: C/A Code, L1 phase, (+ L2 phase, P2 code)

1. Short baseline case - same atmosphere (at UNB campus)
: C/A and L1 code/carrier phase measurements

: Never use the L1 and L2 combination, e.g. ionosphere-free linear
combination due to the amplification of the noise.

: GGE2012 practice.
2. Longer baseline case - different atmosphere (over 10 km)

: Either C/A + L1 phase with the method of atmospheric error mitigation,
or C/A + both L1 and L2 phase combination to mitigate errors mainly
by the ionosphere. Frequently, this combination is referred to as
“ionosphere-free combination”: GGE2013 practice.
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Processing GPS Data
€ GPS Processing Introduction: TGO™

: Post mission

: Solutions are too optimistic (only mathematical correlation is
considered)
: Limited analysis

: Commercial software can hardly guarantee the accuracy of less than
cm from the true value in static mode. In a real-time mode or RTK mode,
the achievable accuracy is lower. You must be very careful for this.

: For those who works for map-matching, land property management,
or low-precision GIS which don’t need a high-precision application

: For those who study for geodetic accuracy, please use other geodetic
software stated before.

11/00 © Yong-Won Ahn © Department of Geodesy and Geomatics Engineering ® University of New Brunswick,

Processing GPS Data
@ GPS Recording in Field:

: One Zephyr/Zephyr
Geodetic Antenna

: One Trimble 5700 Rx
: One TSCe™ Controller
: One Triback

: One Tripod

: Cables (Coaxial to Rx,
BNC type, Controller)
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Processing GPS Data
€ GPS Data Preparation:

: Not general scheme, only for Trimble Rx and Software related

: Download the *.dc controller files from controller using RS232 port
(please see the diagram below)

Connecting Cable
from TSCe to

Computer’s COM
port (or USB port)
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Processing GPS Data
€ GPS Data Preparation: Two Options

1. From TSCe Controller, you can download *.dc file
and *.dat. They can be processed in TGO software

2. Secondly, you can download raw data from flash
card in the receiver. These data sets should be
converted to the standard form. (preferred)
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Processing GPS Data
€ GPS Data Preparation:

: Once the cables are connected, then please launch the program, “Data
Transfer”

: You also have to set up the PC communication in the TSCe controller to
connect each other (between TSCe and Computer)

:If TSCe is ready to be connected, please choose the proper device and
click the connection button (see below)

: Once succeeded, you must add

the file and then choose

B0 (66 tne | D—Fd’
transfer all = HotCormiet
: *.dc file and *.dat will be e -t
downloaded.
oo | b | Do |
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Processing GPS Data
€ GPS Data Preparation:

: Another way to download the GPS data is from the CF (compact flash)
memory card directly.

: I prefer to this way as we don’t need to be dependent of a controller.
Also, it will minimize your mistake of the controller settings. Strange
thing I've found is that once the controller is close earlier or once you
failed to end the survey on the controller, the download data from the
controller had a problem. It failed to be downloaded all spans.

: Please follow this way at least for the Trimble Rx and TSCe controller
for our GPS lab.

- Download the raw data (in *.T01 format) from CF memory card

> Transfer from the raw format (*.T01) to *.dat with the following
program: runpkr00.exe
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Processing GPS Data
€ GPS Data Preparation:

: Download the program, called “R-Utilities” from

: use the following sentence to decode the *.t01 file

: runpkr00 -d -tt01 file_name.t01 file_name.dat

(You may also download the program from the course Blackboard.
Please try to find the program yourself first.)

accessed on 21 March,
2011)

17/00 © Yong-Won Ahn © Department of Geodesy and Geomatics Engineering ® University of New Brunswick,

Processing GPS Data
& Important Setup for TGO™:

1. Please find the attached the file (Current.csd) in Blackboard which
you are going to use to set up NB Double Stereographic Projection
with NAD83 CSRS datum. You should copy this file to the following
directory or the corresponding directory TGO is installed.

c:\Program files\Common files\Trimble\Geodata

2. After you copy it, go to TGO and follow the below instructions:
File > Project Properties - Coordinate System >

Coordinate System Settings - Change ->

Coordinate System and Zone (- Canada and Plane Rectangular) >

No Geoid Model - Finish > Apply
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Processing GPS Data

You must see the T1iubie teomatios e - 65 1657 [ 1] 1
following on the .. - S5 alN BeR s o=l

project properties.

If different, please
see previous file

and find out the

problem. - Sdboirest
B0 IE @2
Egmpag T

If this is different, — =25 aaer

?
HE AN BLIE

your entire
TR DL MOIER BRE)L

project for
GGE2012 and
GGE2013 will be
wrong.

TEEERE FE0NZ 1542m, 1.136m
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Processing GPS Data

Go to & Trimble Geomatics Office
File-> New
- make project
name Eﬁ
(should be metric = |
system) | | B
DATA_TEST_wihT6D AL, _top_ |
2 OK | i
g v
® srarg
r BRAER)
SN2E
SERERE TN
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Processing GPS Data

Go to g

File> Import >
GPS data file
(*.dat)

¥ D& A sas e Ra aRE ET

MR =20
85 |Cap /oS0 | AHETR
T 8 0w [ oat ol

AE T B

5 0I0/El D128 JHRSLICH Fit1.542m, 1.136m
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Processing GPS Data

You may see the following file lists on DAT check-in. Most important
parts are the antenna height, antenna types, and reference points of
antenna (either “bottom of notch, top of notch, or antenna phase
center for each antenna which you used). You “HAVE TO” input the
corresponding values on each field “EXACTLY”. Most important !!!

“IDAT Al =191 N B %]

[R] oE [ mw om [ A= AP | @A NS =421 BE[x00 s ey go oau &% | gol A [l ms 3c |
fF stm BETAT191. 00t 121U5:h7 29 b 2007 15:0W147 20 b 2007 5700 hAGTa067H 1.4%?n Zephyr Gredetic  Bottom of notch
F| @ path BATAT192. 00t 15519517 29 b 2007 1611117 29 & 2o07 5700 haea0G7d 1.487m Zrphyr Gredetic  Bottom of notch
5| @ oronocts  @47A1193.dat 17:06:67 29 4 2007 17:58:17 29 K 2007 5700 hai00G7H 1.52m Zephyr Gredetic  Bottom of notch
Wl F 1 BATAIZ01.dat 10:12355 40 4 2007 10:51:23 38 & 2007 S7a0 Waedons7 #1158 Zephyr) SHEIL| WOI= dE
5| 7 for 26191190, 00t 13524517 29 b 2007 13158147 20 & 2007 5700 haiaz6i9 0.176n Zephyr Gredetic  Bottom of notch
6| @ chapran  26191191.0at 1832517 29 4 2007 143577 29 A 2007 5700 haedaz19 1.581m Zephyr Gradetic  Bottom of notch
7] @ 1ot 26191192 .0at 1611517 29 b 2007 1816117 29 & 2007 5700 WA 2619 1.518m Zephyr Gredetic  Bottom of notch

This includes: Antenna Height, Antenna Type, and
Antenna Reference Point (Always use the Phase
Center and input your “hand-calculated” phase
center value for your antenna for exercise!!!

Y I M k3
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Processing GPS Data

. < Trimble Geomatics Office - GPS_TESt - [£3f] =1 %
Now, you will see  Gige sz =iw 290 65 &z SE¥H SrF
“ D 6B A ] 2

the corresponding

network diagram 'm:‘_:?
for your GPS
observations

(Left is just an
example from
GGE2013 survey
practicum II)
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Processing GPS Data

Go to J
Surveying 2 ¢ D& 58 - -jef[vferaan mBE|v@
GPS Baseline

Processing
Style

Edit-> Select
mask angle to A
5 deg. 2 Orbit
(Either
broadcast or
precise) 2>
Fixed type
solution

Advanced >
please see the
details of each
tab.

Trimble Default

S | K| @2 | B 0RY |pog | omE | orga |

R Tembin Diedaut
[ Fromble Gieiaa [0 Mk

S 2R (AZHEE

28 HOIE DB

o

R =R

WEAZREL [Disdcant

e

[Foeed

CEvEnE RRUAR 5 194074650, 13753,006m v
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Processing GPS Data

Go to Surveying 2>
GPS Baseline
Processing (F9): it
will process your
“selected” baselines.

After finished, you
will see the similar
result like the left.

Please save the file
and see all the
details from the
saved file.

B 19407 AtHm, 101723
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Processing GPS Data
@ Cycle Slip Manipulation

e “8 : Make a project and
copy all *.dat to

checkin directory.

8 vema o T Om At IHMETY 4M

il
oS
®
3

: View 2 Timeline

(check the time line
and then decide if
there’re any data to
| remove or not to be
processed, minor!)

: Cycle slip elimination
(check the jumps and

! = deactivate those)

26/00 © Yong-Won Ahn * Department of Geodesy and Geomatics Engineering ® University of New Brunswick,

13



Processing GPS Data
€ GPS Network Adjustment: Fixed Control Point

: Bring all GPS data

: Check the antenna height or put the correct APC of the
antenna

: Click Process button (will take time)
: Baselines can be seen (as white line) in TGO™

: Adjustment will be done by selecting the baselines that make
a triangle network

: Selected and then click the Adjust button
: Report > Network Adjustment Report
: Analysis the results
Gillin Hall (NAD83 CSRS)

Note: Fixed Point (Gillin Hall): From GPS Lab. Lat: 45 57 0.9478

(Applied to TGO and adjusted based on this) Lon: 66 38 32.2343
Hgt: 18.362 m
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Processing GPS Data

After processed the
baseline oo R O L
successfully, go to ey |

Adjustment. Check me |

L]

Adjust to NAD 1983 — =
(Canada) &

Points 2 you must
fix “Gillen Hall”
with the
coordinates
provided.

= _7EN 67518
THIRGEH.5TH TRROTI0. M -7.1%m 7.
sub THIRZRI.2N9 2NRORIP.THT AI.70En N1.THE
THIBSHY 418 2HBAFLS. 118 27.921n

iﬁ
Adjustment 2> &
A
Al

Adjustment 2>
Adjustment (F10) 1
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Processing GPS Data

After the adjustment, you can find the final adjusted coordinates
from the “adjustment report”.

From the report, your final horizontal coordinates will be one like

below. You have to make it sure whether Gillin Hall is correctly
fixed or not.

Adjusted Coordinates

point name Lat. N Err Long. E Err Ell.LHgt. HError Fixed
md 45°56'33 29392"N|(0.003m [66°38'35.92491"W/ 0.002m)| 62.514m || 0.006m

kin-g1 45°56'52.93538"N10.008m [66°38'19.65835" W 0.004m||_-2.149m 0.010m |
gilin 45°57'00 94780"N][0.000m [66°38'32 23430"W] 0.000m| 18,953m|| 0.000m|[% = A% h|
sub 45°56'40 70220"N|[0.002m [66°38'28.88653"W0.002m|| 43 708m| | 0.006m

hil 45°56'49.31809"N|[0.003m [66°38'33.30424" W 0.003m|| 27.921m|| 0.008m

These heights are the ellipsoidal ones: You have to
change them to the orthometric height.
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Processing GPS Data: Review

I:msmean:x u-:mw”mw‘ — S| [Check]
" : SkyPlot
- : Survey Plan
S : DOP Check
(must be pre-
i determined)
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Processing GPS Data: Review
€ Antenna Height (Pl. use APC)

: Please calculate antenna
phase center (APC) values
provided on the back of the
antenna.

: Zephyr Geodetic™ Antenna
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Processing GPS Data: Review
¢ Antenna Height (Pl. use APC)

: Please calculate antenna
phase center (APC) values
provided on the back of the
antenna.

: Zephyr Antenna
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Processing GPS Data: Review
€ Antenna Height (Pl. use APC)

: Please calculate antenna ALL DIMENSIONS (N
phase center (APC) values :
provided on the back of the
antenna.

: Micro Centered L1/L2
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Processing GPS Data: Review

€ TIP: Concerned about geometry and
visibility?
[ ik T ok el D07 03 71 bl ¥ i T, ihe] 8=

: Please use the “Planning”
Tool before you start

surveying! o R —— .
: Can you find any bad time i T ]
for your survey schedule ”llilt]l I‘I[‘m‘li

from the right figure?

DO fall}

: You can check them in any
time and any location in the
world if you provide the
proper almanac to the
software (it’s in the TGO
utilities!)
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Processing GPS Data: Review
@ TIP: Need a pre-analysis in detail?

: Please use TEQC quality check program provided by UNAVCO

: You can download it from the link

: It can manipulate, concatenate, pre-analyze, pre-processing GPS,
GLONASS, SBAS
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WGS84 System

Earth-Centered Earth-Fixed (ECEF) Coordinate
System

- For the purpose of computing the position of a GPS Receiver
- Rotate with the Earth
- The Characteristics of ECEF
- Originate at the center of the Earth
- xy-plane : coincide with the Earth’s equatorial plane
+x-axis : Point in the direction of 0° longitude
+y-axis : 90° E longitude
- +z-axis : Normal to the equatorial plane in the direction
of the geographical north pole
- The satellite position & velocity vectors must be available in the
ECEF for GPS navigation problem
- In the case of GPS positioning, Cartesian coordinates (X,Y,Z) of the
user’s receiver are computed
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WGS84 System
World Geodetic System (WGS84 )

- Standard physical model of the Earth for GPS

- The Characteristics of WGS84
- Originate at the center of the Earth
- a:6378.137 km = Mean equatorial radius
- b:6,356.7523142 km
- e: Eccentricity of Earth Ellipsoid = 0.0818
c : speed of light = 299,792.458 km/s
- f: flattening =1 - b/a
e’ : second eccentricity = eb/a
= 0.0820944379496

38/00 © Yong-Won Ahn * Department of Geodesy and Geomatics Engineering ® University of New Brunswick,

19



WGS84 System

Geodetic Coordinates System

ECEF coordinate with the reference ellipsoid (for
example WGS84) called Geodetic coordinate
- So called Geographic coordinate system

Geodetic longitude (1)
- The angle between the user and the x-axis measured in the
xy-plane
Geodetic latitude (¢)

- The angle between the ellipsoid normal vector & projection
of it into the equatorial plane

Geodetic height(h)
- Relative to the WGS84 ellipsoid not to the geoid

- Minimum distance between the user and the reference
ellipsoid(i.e. ellipsoid normal)

39/00
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GPS Height

Height

Geodetic (Ellipsoidal) Height; h

. The height above the ellipsoid. Ellipsoidal height is geometric, not a physical

parameter and is what is given by the GPS technique.

Orthometric Height; H

. The height above MSL. Orthometric height is a physical parameter and is what

is given by most conventional surveying techniques. It is the level surface that
a body of water will conform to. In this section (H) is obtained using the GPS
observed ellipsoidal height (h) and correcting it with the Geoid/Ellipsoid
separation (N) and the geoid model. For all pillar type HPN this value can be
compared with the leveled height.

40/00
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GPS Height
Height

Geoid ellipsoidal separation (N):

: Is the distance between the ellipsoid and geoid at a specific point and is also
known as the Geoid Undulation. The separation added to the orthometric (sea
level) height (H), results in the ellipsoid height (h). The following formulae is of
particular importance with the use of GPS.

GPS

h=H+N

where
h = is the ellipsoidal height

Oief

(height usually obtained with GPS) ns / A = W SN '|
H = is the orthometric height (sea-level) __" v oo B e
N = is the geoid ellipsoidal separation
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GPS Height
Height
GPS-H:
- GPS Height Transformation Packages.

- Online or Offline programs are provided. Offline
program, called “gpsh-e.zip” released on Nov. 2001,
is Winl16 environment. Please check your computer
to install it.
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GPS Height

Height
- gl =l1X  Geoid Model:
-~ Geoid Model — Computatian Method
_ .G‘amm/’d CGG2000 - Canadian
IEGG2DDD[GeoldHe|ght] j Erowse ... | il it e Gravimetric Geoid

€ Gesid Made! + Bias model 2000 is a
scientific model of the
geoid for North

— Statior —Fil America from gravity

data up to 2000.
IUNB GILLIN H VI ™ Cortrel Input .. | Free vl

Latitude [DMS] [N 4557 098074
Longitude [DMS) [l 66 38 32.22587 Confral. | |
E

Elipsoidal Height [m) I'I 8.3620

-~ Longitude Code Beference System
:‘ ’7

& west © East || & NADS3(CSRS98) © ITAFSE || € Geoid Model + 4-Farameter Tians,

Geoid Height [m] I-W 497 Dutput ... | Diefault vl
Orthometric: Height [m) |33.33
-~ Format: — Mumber of Stations
Model | [Fput | Cortrol | [HitEut | 1 Station
Help | Feset | Done | 9 [l Natural Resources Canada
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GPS Height
Height

The Geoid model contributes to the vertical component of the
reference system so that ellipsoidal GPS heights can be
converted to orthometric elevations for practical uses.

The real challenge lies in knowing the relationship between
the ellipsoid and the geoid. Once we determine the difference
between these two surfaces, called the "geoid-ellipsoid
separation” or "geoidal height", at a given point, we can then
apply the geoidal height to our GPS height measurement to
get the mean sea level elevation. (from NRCan website)

44/00 © Yong-Won Ahn * Department of Geodesy and Geomatics Engineering ® University of New Brunswick,

22



GPS Height
Height

Online Service (from NRCan website)

Canadian Spatial Reference System :
GPS-H 2.1 Geoid Height Transformation Program Please lnpUt

coordinates manually
[GPS-H - Infa]
Geoid Model : HT 2.0 (Height transformation)

HTW2.0 = CGG2000 (Scientific geoid mode) + HRGO {Corector Surface)
alfows the direct transformation of NADS3 or ITRF elljpsoidal heights to
CGYD28 onthometric heights (height above mean sea level)

Longitude Code @west O east

Reference System @ NADEI OITRF /
Latitude:  degrees |45 minutes &7 seconds (02.18748
Longitude: degrees BB minutes 38 seconds 2768119
Ellipgoidal Height (m) 12689

|
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